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Warranty and Disclaimer

© Cypress Semiconductor Corporation, 2014-2019. This document is the property of Cypress Semiconductor Corporation and its subsidiaries, including

Spansion LLC (“Cypress”). This document, including any software or firmware included or referenced in this document (“Software”), is owned by Cypress

under the intellectual property laws and treaties of the United States and other countries worldwide. Cypress reserves all rights under such laws and treaties

and does not, except as specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights.

If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of the

Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to sublicense) (1) under its copyright rights in

the Software (a) for Software provided in source code form, to modify and reproduce the Software solely for use with Cypress hardware products, only

internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resellers

and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents that are infringed by the Software (as

provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware products. Any other use,

reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO

THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make

changes to this document without further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described

in this document. Any information provided in this document, including any sample design information or programming code, is provided only for reference

purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality and safety of any application made of this

information and any resulting product. Cypress products are not designed, intended, or authorized for use as critical components in systems designed or

intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems (including

resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other uses where the failure of the device or

system could cause personal injury, death, or property damage (“Unintended Uses”). A critical component is any component of a device or system whose

failure to perform can be reasonably expected to cause the failure of the device or system, or to affect its safety or effectiveness. Cypress is not liable, in

whole or in part, and you shall and hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of

Cypress products. You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other liabilities, including claims for

personal injury or death, arising from or related to any Unintended Uses of Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are

trademarks or registered trademarks of Cypress in the United States and other countries. For a more complete list of Cypress trademarks, visit cypress.com.

Other names and brands may be claimed as property of their respective owners.
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Overview

▪ MCU Features, Board Features & Contents

▪ Test it

▪ The Hardware

▪ The Jumper Table / Jumper Default 

▪ Board Power

▪ Software Examples & Tools

▪ Flash Programming

▪ JTAG / CMSIS-DAP

▪ IAR-Embedded Workbench

▪ KEIL µVision

 Additional documents

 Schematics

 Data sheet S6E2CC Series

 Peripheral Manual

 Timer part

 Analog part

 Communication part

 Ethernet part

 Flash programming manual

http://www.cypress.com/documentation/development-kitsboards/fm4-216-ethernet-arm-cortex-m4-mcu-development-kit-ethernet-can
http://www.cypress.com/file/257946/download
http://www.cypress.com/file/235126/download
http://www.cypress.com/documentation/technical-reference-manuals/32-bit-microcontroller-fm4-family-peripheral-manual
http://www.cypress.com/file/222986/download
http://www.cypress.com/file/222981/download
http://www.cypress.com/file/222976/download
http://www.cypress.com/file/222961/download
http://www.cypress.com/file/252581/download
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Features of the S6E2CC Microcontroller

Package:
LQFP144, LQFP176 , BGA192 , LQFP 216, 

ARM Cortex-M4 – CPU

200MHz (max)

2.7-5.5V

MPU, FPU

Ta= -40°C to +105°C

Main CLK: 4MHz

SUB CLK: 32kHz

MAIN RC CLK: 4MHz

SUB RC CLK: 100kHz

Subclock (option)

RC oscillator +/-2%

Clock Supervisor

Watch Counter

Low Voltage Detector  2ch

DMA

8ch

External IRQs

32ch + NMI

RTC

Y:M; h:m:sS6E2CC9H/J/L

S6E2CC8H/J/L

12-bit ADC

ADT x 3ch FRTim x 3ch

OCU x 6ch ICU x 4ch

Waveform

Generator
Multi Function Timer

3ch

Dual Timer

12-bit ADC

12-bit ADC

QDU 4ch

S6E2CCAH/J/L

USB FS Host+Function 2ch 

CAN (32 MSB) 2ch

CRC

Base Timer

16ch

Ethernet MAC 10/100MBit

PPG 9ch

SRAM

128K

FLASH

1MB

SRAM

192K

FLASH

1.5MB

SRAM

256K

FLASH

2MB

SWJ/TPIU/ETM Debug Ports

Resource

Pin Relocation

Quad SPI

CAN-FD 1ch

32ch

12-bit DAC

2ch

MFS(UART/SPI/I2C) 16ch

External Bus Interface

(SRAM, SDRAM, NAND, ..)

DSTC 256ch

Hardware Watchdog

I2S

SD Card I/F
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Features of the board

▪ Features of the FM4-216-ETHERNET board:
• Microcontroller Cypress FM4 S6E2CCAL0A

• FM connect Ethernet: 1x IEEE802.3 Ethernet

• FM connect CAN: 2x CAN transceiver + 1x CAN-FD transceiver

• FM connect USB: 2x USB-Host (Type-A connector), 1x USB-Device (Type-B connector)

• FM touch: Slider using four ADC channels

• FM inverter: Motor-Control-Interface for e.g. POWER-3P-LV2-MC

• FM color: Cypress S/W TFT interface

• Cypress flash memory S25FL164K, connected via quad SPI interface

• I²S audio interface

• SD Card interface

• 1x USB-to-serial converter (Type-B connector) using Cypress FM3 MB9AF312K

✓ UART and on-board JTAG simultaneously (CMSIS DAP)

• Additional JTAG and Trace Interfaces each on a 20 pin-header

• 2x Cypress Multicon flexible serial interface supporting I²C, SPI, UART, and LIN

• User interface

✓ Backlit LCD module

✓ 5x pushbuttons (User buttons), potentiometer

✓ 1x Reset-button, Reset-LED

• All 216 pins routed to pin-header

• On-board 5V and 3V voltage regulators to supply MCU with separate Power-LEDs

• 4x Power supply options: USB, USB-Device, JTAG or external 9V to 24V
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Contents FM4-216-ETHERNET

▪ The FM4-216-ETHERNET box contains

• The FM4-216-ETHERNET evaluation board

• USB cable

• Ethernet cable

• CD: Documentation, software examples and development utilities

• 1-page flyer  

ESD foam           ESD box          FM4-216-ETHERNET          USB, Ethernet cable 

CD ROM           Additional information

A B

RJ45 RJ45
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Test it

▪ The microcontroller on the  FM4-216-ETHERNET

is already preprogrammed with an example application (<drive:>\Examples\fm4-216-ethernet-tp_v12.srec).

▪ Verify that jumpers JP75 and JP77 are set to 1-2 position and jumper JP76 is set to 3-4 position

▪ Connect the FM4-216-ETHERNET via DEBUG USB port (X2) with the PC

▪ Verify that switch S1 is set to RUN

▪ Press the Reset-button

▪ The FM4-216-ETHERNET‘s display will show a greeting message

▪ Using the Up and Down pushbuttons will scroll through a menu on the LCD module

▪ Connect X3 (static IP address 192.168.1.20) to a PC or local area network

▪ Configure your PC to an untaken IP address within the same subnet (such as 192.168.1.42)

▪ Point your webbrowser to board‘s IP address (192.168.1.20)

▪ Install the USB Driver first <drive:>\drivers\driverinstaller.exe

▪ Check the availibility for virtual COM port e.g. with Windows Device Manager

▪ Open a serial terminal tool

▪ e.g. Cypress Serial Port Viewer

<drive:>\tools\serialportviewer\setup.exe

▪ Settings 115200 baud, 8N1

▪ More board tests are available via serial console
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Test it

▪ You finished successfully the first tests

▪ Now you will get more details about the

FM4-216-ETHERNET

▪ You will learn more about 

• The on-board features

• How to program the Flash

• How to start with IAR-Embedded-Workbench and KEIL µVision
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Hardware
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The Hardware (Top Side) – Function Overview

Vin: 9..24VDEBUGCAN2 (FD) CAN1USB Host 

0/1
USB 

Device

Ethernet

S6E2CCAL0A

Flash

Run/Prog 

switch S1

Trace

JTAG

Reset 

button

MultiCon 0/1

Variable 

Resistor

Power 

switch S2

CAN0

2x16 LCD Module

Five user buttons

FM touch

Audio Interface

MB9AF312K

Motion Control I/F

SD Card I/F

TFT Interface
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Jumper Settings – Power the starterkit

▪ The starter kit can be powered by

• External power supply (9-24V)

✓ Set jumpers JP75 and JP77 to position 1-2

Caution: Always set JP75 and JP77 horizontally, never vertically!

✓ Connect X1 to 8..24V DC power

✓ Switch S2 into ON position

• USB

✓ There are three ways to power the starter kit via USB

✓ Set jumpers JP75 and JP77 to position 2-3

✓ Set jumper JP76 according to the desired power source:

• For CAN2 (CAN FD), external power supply must be used, not USB

ON

JP76 Power source Connector

1-2 USB Device X12

3-4 DEBUG X2

5-6 JTAG (ensure that adapter can provide enough current for 

your application! Some JTAG probes source insufficient 

power and some features might misbehave unexpectedly)

J14
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The Hardware – Connectors

J6

X2 X1

J1

J5

J4

J2

J8

J7

J11

J9
J10

J12

J13
J14

J3

J15

J17J18

J16

J20 J19

X4X7X10X11X12X3

X9 X8 X6 X5

X13
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Connectors

Connectors FM4-216-ETHERNET

Number Description

J1 MCU pins 163..216

J2 MCU pins 1..54

J3 VCCin (1: before switch, 2: after switch)

J4 MCU pins 55..108

J5 MCU pins 109..162

J6 4x GND

J7 2x 5V

J8 2x 3V3

J9 Multicon 0

[J10] Multicon 0 optional

J11 Multicon 1

[J12] Multicon 1 optional

J13 Trace

J14 JTAG

J15 Motor drive interface

J16 Motor I/F: Optional signals

J17 Hall Sensors

J18 QPRC

[J19] Display RGB888 connector

[J20] FPC/FCC connector

Number Description

X1 DCin 9..24V

X2 Debug

X3 Ethernet

X4 CAN0

X5 Audio line out

X6 Audio headphones out

X7 CAN1

X8 Audio microphone in

X9 Audio line in

X10 CAN2 (CAN FD)

X11 USB Host (0/1)

X12 USB Device

X13 SD Card Connector
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Jumper Settings – (Top Side)

: default position

JP4

JP8

JP9

JP18

JP22

JP10
JP44

JP79, 80

JP73

JP26JP28JP40JP42

JP21

JP70

JP71

JP56
Solder 

Jumper

Regular 

Jumper

JP13

JP62

JP76

JP75

JP77

JP5
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Jumper Settings – (Bottom Side)

JP45, 46, 50-53, 59

JP72

JP1JP3

JP16, 17

JP14, 15

JP54, 55, 60, 61

JP36-39

JP43

JP63-69JP29-32

JP2

JP11, 12 JP6, 7

JP78

JP81

JP74

JP19, 20

JP23, 24, 27 JP34, 35, 41 JP33 JP49 JP47JP48

JP57, 58

JP25Solder 

Jumper
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Jumper

Jumper Settings FM4-216-ETHERNET

Number Description Special Type Default

JP1 USBVCC0 Solder Jumper Closed

JP2 USBVCC1 Solder Jumper Closed

JP3 ETHVCC Solder Jumper Closed

JP4 MCUVCC Closed

JP5 USB/UART programming Closed

JP6 X0A Access Solder Jumper Closed

JP7 X1A Access Solder Jumper Closed

JP8 AVRH Closed

JP9 AVCC Closed

JP10 AVRL Closed

JP11 X0 Access Solder Jumper Open

JP12 X1 Access Solder Jumper Open

JP13 VBAT Closed

JP14 Multicon0: SCL pull-up Solder Jumper Open

JP15 Multicon0: SDA pull-up Solder Jumper Open

JP16 Multicon1: SCL pull-up Solder Jumper Open

JP17 Multicon1: SDA pull-up Solder Jumper Open

JP18 DBG Prog (S/W upgrade U2) Open

Number Description Special Type Default

JP19 MFS0_SOT Solder Jumper Closed

JP20 MFS0_SIN Solder Jumper Closed

JP21 EthPHY IRQ Solder Jumper Closed

JP22 Supply VCCin from motor Open

JP23 CAN0GND4 Solder Jumper Open

JP24 CAN0GND6 Solder Jumper Open

JP25 CAN0pwr Solder Jumper Open

JP26 CAN0RX Solder Jumper Closed

JP27 CAN0term Solder Jumper Open

JP28 CAN0TX Solder Jumper Closed

JP29 LCDRST Solder Jumper Closed

JP30 HMISCL Solder Jumper Closed

JP31 HMISDA Solder Jumper Closed

JP32 LCDBL Solder Jumper Closed

JP33 CAN1pwr Solder Jumper Open

JP34 CAN1GND4 Solder Jumper Open

JP35 CAN1GND6 Solder Jumper Open

JP36 I2SDO Solder Jumper Closed
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Jumper

Jumper Settings FM4-216-ETHERNET

Number Description Special Type Default

JP37 I2SDI Solder Jumper Closed

JP38 I2SCK Solder Jumper Closed

JP39 I2SWS Solder Jumper Closed

JP40 CAN1RX Solder Jumper Closed

JP41 CAN1term Solder Jumper Open

JP42 CAN1TX Solder Jumper Closed

JP43 I2SMCLK Solder Jumper Closed

JP44 I2SAGND Solder Jumper Closed

JP45 CAN2RX Solder Jumper Closed

JP46 CAN2TX Solder Jumper Closed

JP47 CAN2pwr Solder Jumper Open

JP48 CAN2GND4 Solder Jumper Open

JP49 CAN2GND6 Solder Jumper Open

JP50 CAN2S Solder Jumper Closed

JP51 CAN2C Solder Jumper Closed

JP52 CAN2O Solder Jumper Closed

JP53 CAN2I Solder Jumper Closed

JP54 Touch AN24 Solder Jumper Closed

Number Description Special Type Default

JP55 Touch AN25 Solder Jumper Closed

JP56 CANFDBAT Solder Jumper Closed

JP57 CAN2termH Solder Jumper Open

JP58 CAN2termL Solder Jumper Open

JP59 CAN2Wake Solder Jumper Closed

JP60 Touch AN26 Solder Jumper Closed

JP61 Touch AN27 Solder Jumper Closed

JP62 POWERON Closed

JP63 Button UP Solder Jumper Closed

JP64 Button RIGHT Solder Jumper Closed

JP65 Button CENTER Solder Jumper Closed

JP66 Button LEFT Solder Jumper Closed

JP67 Button DOWN Solder Jumper Closed

JP68 Button IRQ Solder Jumper Closed

JP69 RP1 Solder Jumper Closed

JP70 EthPHY XO Solder Jumper Closed

JP71 EthPHY XI Solder Jumper Closed

JP72 Ethernet Yellow LED Solder Jumper Closed
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Jumper

Jumper Settings FM4-216-ETHERNET

Number Description Special Type Default

JP73 I2S48.1k Solder Jumper Closed

JP74 USB HCONX Solder Jumper Closed

JP75
1-2: External power supply
2-3: Supply via USB or JTAG

JP75 must 
equal 77

1-2

JP76
1-2: USB Device (X11)
3-4: Debug port (X2)
5-6: JTAG (J11) (watch voltage!)

Only relevant 
if JP75 and 
JP77 set to 2-3

3-4

JP77
1-2: External power supply
2-3: Supply via USB or JTAG

JP75 must 
equal 77

1-2

JP78

SD_CD:
1-2: CD
2-3: CD/DAT3 Solder Jumper 1-2

[JP79] Backlight enable Open

[JP80] Backlight dimming Open

[JP81] LCD power control 1-2
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Hardware

Pin-List FM4-216-ETHERNET (1/9)

Pin Function Description

1 VCC MCUVCC

2 PA0/RTO20_0/TIOA8_0/AIN2_0/INT00_0/MADATA00_0 Pushbutton UP

3 PA1/RTO21_0/TIOA9_0/BIN2_0/MADATA01_0 Pushbutton RIGHT

4 PA2/RTO22_0/TIOA10_0/ZIN2_0/MADATA02_0 Pushbutton CENTER

5 PA3/RTO23_0/TIOA11_0/MADATA03_0 Pushbutton LEFT

6 PA4/RTO24_0/TIOA12_0/MADATA04_0 Pushbutton DOWN

7 PA5/SIN1_0/RTO25_0/TIOA13_0/INT01_0/MADATA05_0 Pushbutton IRQ

8 PA6/SOT1_0/DTTI2X_0/MADATA06_0

9 PA7/SCK1_0/IC20_0/MADATA07_0

10 P50/SCS72_0/RTO00_1/TIOA8_2/MADATA16_0 Motor0/MFT0

11 P51/SCS73_0/RTO01_1/TIOB8_2/MADATA17_0 Motor0/MFT0

12 P52/RTO02_1/TIOA9_2/MADATA18_0 Motor0/MFT0

13 P53/RTO03_1/TIOB9_2/MADATA19_0 Motor0/MFT0

14 PA8/SIN7_0/IC21_0/INT02_0/WKUP1/MADATA08_0 Ethernet PHY IRQ

15 PA9/SOT7_0/IC22_0/MADATA09_0

16 PAA/SCK7_0/IC23_0/MADATA10_0 USB (Host1 VBUS enable)

17 PAB/SCS70_0/RX0_0/FRCK2_0/INT03_0/MADATA11_0 USB1 Overcurrent IRQ

18 PAC/SCS71_0/TX0_0/TIOB8_0/AIN3_0/MADATA12_0 Motor0/QPRC3

19 P54/SIN15_1/RTO04_1/TIOA10_2/INT00_2/MADATA20_0 Motor0/MFT0

20 P55/SOT15_1/RTO05_1/TIOB10_2/MADATA21_0 Motor0/MFT0

21 P56/SCK15_1/DTTI0X_1/TIOB0_1/MADATA22_0 Motor0/MFT0

22 P57/IC00_1/TIOB1_1/MADATA23_0 Motor0/IC0

23 PAD/SCK3_0/TIOB9_0/BIN3_0/MADATA13_0 Motor0/QPRC3

24 PAE/ADTG_0/SOT3_0/TIOB10_0/ZIN3_0/MADATA14_0 Motor0/QPRC3
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Hardware

Pin-List FM4-216-ETHERNET (2/9)

Pin Function Description

25 PAF/SIN3_0/TIOB11_0/INT16_0/MADATA15_0

26 P58/SIN11_1/IC01_1/TIOB2_1/INT02_2/MADATA24_0 Motor0/IC0

27 P59/SOT11_1/IC02_1/TIOB3_1/MADATA25_0 Motor0/IC0

28 P5A/SCK11_1/IC03_1/TIOB4_1/MADATA26_0

29 P5B/FRCK0_1/TIOB5_1/MADATA27_0

30 P08/SIN14_0/TIOB12_0/INT17_0/MDQM0_0

31 P09/SOT14_0/TIOB13_0/INT18_0/MDQM1_0

32 P0A/ADTG_1/SCK14_0/AIN2_1/MCLKOUT_0

33 P5C/TIOA11_2/MADATA28_0/RTCCO_1/SUBOUT_1 Motor0 OPT1 (Brake)

34 P30/RX0_1/TIOA13_2/INT03_2/MDQM2_0/I2SDI_0 I2S serial receive data input pin

35 P31/TX0_1/TIOB13_2/MDQM3_0/I2SCK_0 I2S bit clock terminal

36 P32/BIN2_1/INT19_0/S_DATA1_0 SD I/F

37 P33/FRCK0_0/ZIN2_1/S_DATA0_0 SD I/F

38 P34/IC03_0/INT00_1/S_CLK_0 SD I/F

39 VCC MCUVCC

40 VSS GND

41 P35/IC02_0/INT01_1/S_CMD_0 SD I/F

42 P36/IC01_0/INT02_1/S_DATA3_0 SD I/F

43 P37/IC00_0/INT03_1/S_DATA2_0 SD I/F

44 P38/ADTG_2/DTTI0X_0/S_WP_0 SD I/F

45 P39/SIN2_1/RTO00_0/TIOA0_1/AIN3_1/INT16_1/S_CD_0/MAD24_0 SD I/F

46 P3A/SOT2_1/RTO01_0/TIOA1_1/BIN3_1/INT17_1/MAD23_0

47 P3B/SCK2_1/RTO02_0/TIOA2_1/ZIN3_1/INT18_1/MAD22_0/MNALE_0

48 P3C/SIN13_0/RTO03_0/TIOA3_1/INT19_1/MAD21_0/MNCLE_0
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Hardware

Pin-List FM4-216-ETHERNET (3/9)

Pin Function Description

49 P3D/SOT13_0/RTO04_0/TIOA4_1/MAD20_0/MNWEX_0

50 P3E/SCK13_0/RTO05_0/TIOA5_1/MAD19_0/MNREX_0

51 P5D/SIN10_1/TIOB11_2/INT01_2/MADATA29_0/I2SMCLK_0 I2S External clock terminal

52 P5E/SOT10_1/TIOA12_2/MADATA30_0/I2SDO_0 I2S serial transmit data output pin

53 P5F/SCK10_1/TIOB12_2/MADATA31_0/I2SWS_0 I2S frame sync signal terminal

54 VSS GND

55 VCC MCUVCC

56 P40/SIN3_1/RTO10_0/TIOA0_0/AIN0_0/INT23_0/MCSX7_0 TFT Connector (CSYNC)

57 P41/SOT3_1/RTO11_0/TIOA1_0/BIN0_0/MCSX6_0 TFT Connector (DE)

58 P42/SCK3_1/RTO12_0/TIOA2_0/ZIN0_0/MCSX5_0 TFT Connector (DCLK)

59 P43/SIN15_0/RTO13_0/TIOA3_0/INT04_0/MCSX4_0 TFT Connector (VSYNC)

60 P44/SOT15_0/RTO14_0/TIOA4_0/MCSX3_0 TFT Connector (HSYNC)

61 P45/SCK15_0/RTO15_0/TIOA5_0/MCSX2_0 TFT Connector (LEDCTRL)

62 C C

63 VSS GND

64 VCC MCUVCC

65 P4A/SIN12_1/AIN0_1/INT04_2 CAN FD control SPI

66 P4B/SOT12_1/BIN0_1 CAN FD control SPI

67 P4C/SCK12_1/ZIN0_1 CAN FD control SPI

68 P4D/SCS72_1/RX2_2/INT05_2 CAN2 (CAN-FD)

69 P4E/SCS73_1/TX2_2 CAN2 (CAN-FD)

70 P7D/SCK1_1/RX2_0/DTTI1X_0/INT05_0/WKUP2/MCSX1_0 CAN FD Wake

71 P7E/ADTG_7/TX2_0/FRCK1_0/MCSX0_0 CAN FD control SPI

72 INITX Reset
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Hardware

Pin-List FM4-216-ETHERNET (4/9)

Pin Function Description

73 P46/X0A [Crystal (Subclock)]

74 P47/X1A [Crystal (Subclock)]

75 VBAT VBAT

76 P48/VREGCTL

77 P49/VWAKEUP

78 PF0/SCS63_0/RX2_1/FRCK1_1/TIOA15_1/INT22_1

79 PF1/SCS62_0/TX2_1/TIOB15_1/INT23_1

80 P70/ADTG_8/SIN1_1/INT06_0/MRDY_0/CEC0_0

81 P71/SOT1_1/MAD00_0

82 P72/SIN9_0/TIOB0_0/INT07_0/MAD01_0

83 P73/SOT9_0/TIOB1_0/MAD02_0

84 P74/SCK9_0/TIOB2_0/MAD03_0

85 PF2/RTO10_1/TIOA6_1/MRASX_0

86 PF3/RTO11_1/TIOB6_1/INT05_1/MCASX_0

87 PF4/RTO12_1/TIOA7_1/INT06_1/MSDWEX_0

88 PF5/RTO13_1/TIOB7_1/INT07_1/MCSX8_0 Multicon0 Reset

89 PF6/RTO14_1/TIOA14_1/INT20_1/MSDCKE_0 Multicon0 (GINT)

90 PF7/RTO15_1/TIOB14_1/INT21_1/MSDCLK_0 Multicon0 (TINT)

91 P75/SIN8_0/TIOB3_0/AIN1_0/INT20_0/MAD04_0 Multicon0

92 P76/SOT8_0/TIOB4_0/BIN1_0/MAD05_0 Multicon0

93 P77/SCK8_0/TIOB5_0/ZIN1_0/MAD06_0 Multicon0

94 PF8/SCS70_1/DTTI1X_1/AIN1_1

95 PF9/SCS71_1/IC10_1/BIN1_1

96 P78/SIN6_0/IC10_0/INT21_0/MAD07_0
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Hardware

Pin-List FM4-216-ETHERNET (5/9)

Pin Function Description

97 P79/SOT6_0/IC11_0/MAD08_0

98 P7A/SCK6_0/IC12_0/MAD09_0

99 P7B/DA1/SCS60_0/IC13_0/INT22_0 ---

100 P7C/DA0/SCS61_0/INT04_1 ---

101 PFA/SCK7_1/IC11_1/ZIN1_1

102 PFB/SOT7_1/IC12_1/INT07_2

103 PFC/SIN7_1/IC13_1/INT06_2

104 PE0/MD1 MD1

105 MD0 MD0/ USB Direct Flash

106 PE2/X0 Crystal (mainclock)

107 PE3/X1 Crystal (mainclock)

108 VSS GND

109 VCC MCUVCC

110 AVCC AVCC

111 AVSS AVSS

112 AVRL AVRL

113 AVRH AVRH

114 P10/AN00/SIN10_0/TIOA0_2/AIN0_2/INT08_0 Motor0/ADC

115 P11/AN01/SOT10_0/TIOB0_2/BIN0_2 Motor0/ADC

116 P12/AN02/SCK10_0/TIOA1_2/ZIN0_2 Motor0/ADC

117 P13/AN03/SIN6_1/RX1_1/INT25_1 Motor0/ADC

118 P14/AN04/SOT6_1/TX1_1 Motor0/ADC

119 PB8/ADTG_6/SCS63_1/INT08_2/TRACED8 TFT Connector

120 PB9/SIN9_1/AIN2_2/INT09_2/TRACED9 TFT Connector
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Hardware

Pin-List FM4-216-ETHERNET (6/9)

Pin Function Description

121 PBA/SOT9_1/BIN2_2/TRACED10 TFT Connector

122 PBB/SCK9_1/ZIN2_2/TRACED11 TFT Connector

123 P15/AN05/SIN11_0/TIOB1_2/AIN1_2/INT09_0 Motor0/ADC

124 P16/AN06/SOT11_0/TIOA2_2/BIN1_2 Motor0/ADC

125 P17/AN07/SCK11_0/TIOB2_2/ZIN1_2 Motor0/ADC

126 PB0/AN16/SCK6_1/TIOA9_1 TFT Connector

127 PB1/AN17/SCS60_1/TIOB9_1/INT08_1 TFT Connector

128 PB2/AN18/SCS61_1/TIOA10_1/INT09_1 TFT Connector

129 PB3/AN19/SCS62_1/TIOB10_1 TFT Connector

130 P18/AN08/SIN2_0/TIOA3_2/INT10_0 Motor0/ADC

131 P19/AN09/SOT2_0/TIOB3_2/INT24_1/TRACECLK TRACE

132 P1A/AN10/SCK2_0/TIOA4_2/TRACED0 TRACE

133 P1B/AN11/SIN12_0/TIOB4_2/INT11_0/TRACED1 TRACE

134 P1C/AN12/SOT12_0/TIOA5_2/TRACED2 TRACE

135 P1D/AN13/SCK12_0/TIOB5_2/TRACED3 TRACE

136 VSS GND

137 VCC MCUVCC

138 PB4/AN20/SIN8_1/TIOA11_1/INT10_1/TRACED4 TFT Connector

139 PB5/AN21/SOT8_1/TIOB11_1/INT11_1/TRACED5 TFT Connector

140 PB6/AN22/SCK8_1/TIOA12_1/TRACED6 TFT Connector

141 PB7/AN23/TIOB12_1/TRACED7 TFT Connector

142 P1E/AN14/TIOA8_1/INT26_1/MAD10_0 Variable Resistor RP1

143 P1F/AN15/RTS5_0/TIOB8_1/INT27_1/MAD11_0

144 P2A/AN24/CTS5_0/MAD12_0 Software Touch



SHOW TITLE MM/DD/YY 25

Hardware

Pin-List FM4-216-ETHERNET (7/9)

Pin Function Description

145 P29/AN25/SCK5_0/MAD13_0 Software Touch

146 P28/AN26/SOT5_0/MAD14_0 Software Touch

147 P27/AN27/SIN5_0/INT24_0/MAD15_0 Software Touch

148 PBC/TX1_2/TRACED12 TFT Connector

149 PBD/SCK0_1/RX1_2/AIN3_2/INT10_2/TRACED13 TFT Connector

150 PBE/SOT0_1/BIN3_2/TRACED14 TFT Connector

151 PBF/SIN0_1/ZIN3_2/INT11_2/TRACED15 TFT Connector

152 P26/TX1_0/MAD16_0 CAN1

153 P25/AN28/RX1_0/INT25_0/MAD17_0 CAN1

154 P24/AN29/TIOA13_1/MAD18_0 LCD Illumination Dimming

155 P23/UHCONX1/AN30/SCK0_0/TIOB13_1 LCD Reset

156 P22/AN31/SOT0_0/INT26_0 UART/(USB-serial)

157 P21/ADTG_4/SIN0_0/INT27_0/CROUT_0 UART/(USB-serial)

158 P20/NMIX/WKUP0 ---

159 USBVCC1 USBVCC1

160 P82/UDM1 USB

161 P83/UDP1 USB

162 VSS GND

163 VCC MCUVCC

164 P00/TRSTX JTAG

165 P01/TCK/SWCLK JTAG

166 P02/TDI JTAG

167 P03/TMS/SWDIO JTAG

168 P04/TDO/SWO JTAG
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Hardware

Pin-List FM4-216-ETHERNET (8/9)

Pin Function Description

169 P90/INT12_1/Q_IO3_0 QSPI Memory

170 P91/SIN5_1/INT13_1/Q_IO2_0 QSPI Memory

171 P92/SOT5_1/INT14_1/Q_IO1_0 QSPI Memory

172 P93/SCK5_1/INT15_1/Q_IO0_0 QSPI Memory

173 P94/CTS5_1/Q_SCK_0 QSPI Memory

174 P95/RTS5_1/Q_CS0_0 QSPI Memory

175 P96/RX0_2/INT12_2/Q_CS1_0 CAN0

176 P97/TX0_2/INT13_2/Q_CS2_0 CAN0

177 PC0/E_RXER Ethernet

178 PC1/TIOB6_0/E_RX03 Ethernet

179 PC2/TIOA6_0/E_RX02 Ethernet

180 PC3/TIOB7_0/E_RX01 Ethernet

181 PC4/TIOA7_0/E_RX00 Ethernet

182 PC5/TIOB14_0/E_RXDV Ethernet

183 PC6/TIOA14_0/E_MDIO Ethernet

184 PC7/INT13_0/E_MDC/CROUT_1 Ethernet

185 PC8/E_RXCK_REFCK Ethernet

186 PC9/TIOB15_0/E_COL Ethernet

187 PCA/TIOA15_0/E_CRS Ethernet

188 ETHVCC Ethernet

189 VSS GND

190 PCB/INT28_0/E_COUT Ethernet Clock Out Option
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Hardware

Pin-List FM4-216-ETHERNET (9/9)

Pin Function Description

193 PCE/SIN4_1/INT15_0/E_TX03 Ethernet

194 PCF/RTS4_1/INT12_0/E_TX02 Ethernet

195 PD0/INT30_1/E_TX01 Ethernet

196 PD1/INT31_1/E_TX00 Ethernet

197 PD2/CTS4_1/FRCK2_1/E_TXEN Ethernet

198 P6E/ADTG_5/SCK4_1/IC23_1/INT29_0/E_PPS Yellow LED on Ethernet connector

199 P6D/SCK14_1/IC22_1/TIOB6_2 HMI SCL

200 P6C/SOT14_1/IC21_1/TIOA6_2 HMI SDA

201 P6B/SIN14_1/IC20_1/TIOB7_2/INT14_2 USB0 Overcurrent IRQ

202 P6A/DTTI2X_1/TIOA7_2 Ethernet PHY Reset

203 P69/RTO20_1/TIOB14_2 Multicon1 Reset

204 P68/SCK13_1/RTO21_1/TIOA14_2 Multicon1

205 P67/SOT13_1/RTO22_1/TIOB15_2 Multicon1

206 P66/SIN13_1/RTO23_1/TIOA15_2/INT15_2 Multicon1

207 P65/RTO24_1/INT28_1 Multicon1 (GINT)

208 P64/CTS4_0/RTO25_1/INT29_1 Multicon1 (TINT)

209 P63/ADTG_3/RTS4_0/INT30_0/MOEX_0 USB (Host/Device Switch)

210 P62/SCK4_0/MWEX_0 USB (Host0 VBUS enable)

211 P61/UHCONX0/SOT4_0/MALE_0/RTCCO_0/SUBOUT_0 USB

212 P60/SIN4_0/INT31_0/WKUP3/CEC1_0 USB Direct Flash / DEVICE_VBUS

213 USBVCC0 USBVCC0

214 P80/UDM0 USB
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Notes

▪ The assembled CAN FD transceiver is specified only up to 2 

Mbits/sec whereas the FM4’s hardware supports up to 5 Mbits/sec

• If a specified 5 Mbits/sec transceiver for CAN FD (CAN2) is needed, the 

8 pin device TJA1044 can be soldered into the 14 pin footprint of the 2 

Mbits/sec TJA1145

• Small software modification necessary

✓ Configure pin P7E as GPIO output

✓ Drive pin P7E low

▪ On a production lot with Spansion branding following errors on the 

silkplot have been found:

• JP5 is labeled USB PROG but must be UART PROG

• The naming labels of RN14 and RN15 near the SD card connector are 

swapped, there is no electrical problem though

• Both errors are rectified on all boards with Cypress branding
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Software
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Software Examples

▪ Software examples for IAR EWARM V6.60 or KEIL µVision5.1:

See <drive:>\Examples\ or www.cypress.com
• s6e2cc_template-v14.zip

✓ ‚Empty‘ project as base for user applications

• s6e2cc_ethernet_driver-v16.zip

✓ Cypress low-level Ethernet driver

• And several more

Note: Please copy the examples to your local drive before compiling!

You can find product information of the

commercially supported TCP/IP stack by SEVENSTAX on this CD.

http://www.cypress.com/
http://www.sevenstax.de/
Sevenstax
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Software Tools

▪ The following software tools are available

• USB Virtual-COM port 

✓ allows UART communciation via the PC‘s USB connection

✓ On-board UART-to-USB converter (via X2, CMSIS-DAP)

✓ For driver installation <drive:>\drivers\driverinstaller.exe

• FLASH USB DIRECT Programmer 

✓ Microcontroller Flash programming (via X12, USB-Device-Port)

✓ Install from  <drive:>\tools\USBDIRECT

• Terminal program ‚Serial Port Viewer‘

✓ Install from  <drive:>\tools\serialportviewer\setup.exe
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Flash Programming
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Flash Programming

▪ There are several options to program the microcontroller’s flash:

• FLASH USB DIRECT Programmer via X12 (USB device)

✓ For installation <drive:>\tools\USBDIRECT\setup.exe 

✓ USB driver is located in subdirectory of FLASH USB DIRECT Programmer 

• FLASH MCU Programmer via X2 (Serial via DEBUG USB/Serial bridge)

✓ For installation <drive:>\tools\PCWFM3-V01L07\setup.exe 

✓ For driver installation of USB/Virtual-COM port

<drive:>\drivers\driverinstaller.exe

• JTAG Programming via X2 (CMSIS-DAP)

✓ Example is given for IAR and KEIL

✓ See documentation of your development suite how to setup CMSIS-DAP

• JTAG Programming via J14 (optional JTAG adapter)

✓ The correct JTAG-adapter must be selected in the IDE toolchain 
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Flash Programming via X12 (USB direct)

▪ FLASH USB DIRECT Programming via X12 (USB device)

• Jumper Setting

✓ Select the MCU power supply (JP75, 76, 77)

✓ Open JP5 (USB PROG)

✓ Set switch S1 to position PGM

• Connect USB port X12 with the PC 

• If connected for first time Windows OS may ask for a driver

✓ See subfolder ‚driver‘ of USBdirect installation path

or use <drive:>\drivers\driverinstaller.exe

• Start the FLASH USB DIRECT Programmer

✓ For first installation: <drive:>\Utilities\USBDIRECT\setup.exe

✓ Select the COM port 

✓ Press Reset

✓ Start Full Operation

✓ Set switch S1 to position RUN

✓ Press Reset
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Flash Programming via X12 (USB device)

▪ Select the correct target MCU: S6E2CCAH0A/J0A/L0A

▪ Browse for the programming file (*.srec or *.hex)

• IAR: see subfolder <project>\example\IAR\output\release\exe

• ARM/KEIL: see subfolder <project>\example\ARM\output\release

▪ Adjust the corresponding virtual COM-port

▪ Use ‚Full Operation‘

• Download kernel

• Erase Flash memory / Blank check

• Program & Verify project to Flash memory

▪ Set switch S1 to position RUN and press Reset button

Select MCU: S6E2CCAH0A/J0A/L0A 

Select file (*.srec; *.hex)

Select Virtual COM-port
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Flash Programming via X2 (Serial)

▪ FLASH MCU Programming via X2 (DEBUG)

• Jumper Setting

✓ Select the MCU power supply (JP75, 76, 77)

✓ Close JP5

✓ Set switch S1 to position PGM

• Connect the board via USB CMSIS-DAP (X2) to the USB-Port of the PC

✓ When connected for first time Windows OS may ask for 

‚cypresssbvcomm.inf‘

<drive:>\drivers\cmsis-dap

• Use the FLASH MCU Programmer for FM3/FM4

✓ For installation <drive:>\tools\PCWFM3-V01L07\setup.exe
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Flash Programming via X2 (Serial)

▪ Select the correct target MCU: S6E2CCAH0A/J0A/L0A 

▪ Select 4MHz Crystal Frequency

▪ Browse for the programming file (*.srec or *.hex)

• IAR: see subfolder <project>\example\IAR\output\release\exe

• ARM/KEIL: see subfolder <project>\example\ARM\output\release

▪ Adjust the corresponding virtual COM-port

▪ Set switch S1 to position RUN and press Reset button

Select MCU: S6E2CCAH0A/J0A/L0A

Select 4MHz Crystal Frequency

Select file (*.srec / *.hex)

Select Virtual COM-port

Execute ‚Full Operation‘

incl. stand-alone operations

- Download Kernel

- Erase

- Blank Check

- Program&Verify
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JTAG Debugger
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JTAG adapter CMSIS-DAP

▪ This starterkit includes an on-board JTAG adapter

• Compatible to CMSIS-DAP 
http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm

• Select debugger CMSIS-DAP in your tool chain

▪ Any other JTAG-adapter can be connected to J14, too.

• The correct JTAG-adapter must be selected in the IDE toolchain

✓ No jumper setting is required

▪ Additional virtual COM port is provided by X2 (DEBUG)

✓ For driver installation <drive:>\drivers\driverinstaller.exe

CMSIS-DAP

(MB9AF312K)
S6E2CCX2 (USB)

JTAG

SIN0/SOT0

J14 (JTAG)

http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm
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JTAG adapter CMSIS-DAP – within IAR EWARM

Setup in IAR EWARM (1)

Navigate to project options:

Via Files-List

Right-click at the project

Select  „Options...“

Or via menu „Project“

Select „Options...“
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JTAG adapter CMSIS-DAP – within IAR EWARM

Setup in IAR EWARM (2)

Setup Project Debbuger Options

(1) Navigate to Debugger

(2) Select tab „Setup“

(3) Select Driver „CMSIS-DAP“

(4) Select in „CMSIS-DAP“

(5) Select tab „JTAG/SWD“

(6) Select SWD

1

2

3

4

5

6



SHOW TITLE MM/DD/YY 42

JTAG adapter CMSIS-DAP – within Keil µVision

Setup in Keil µVision (1)

Navigate to project options:

Via Project

Right-click at the project

Select „Options...“

Or via menu „Project“

Select „Options...“
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JTAG adapter CMSIS-DAP – within Keil µVision

Setup in Keil µVision (2)

Setup Debug & Utilities

(1) Select tab „Debug“

(2) Select „CMSIS-DAP Debugger“

(3) Select tab „Utilities“

(4) Select „CMSIS-DAP Debugger“

1

2

3

4
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CMSIS-DAP Firmware update

Please see instructions contained in firmware update package!
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IAR Embedded Workbench

Installation

Getting Started

Open Project

Build Project

Debug Project
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IAR Workbench Getting Started

▪ Install EWARM from IAR-CD or download latest version from IAR 

Website

• EWARM size-limited (32k) or time-limited (full) Evaluation Version

✓ http://supp.iar.com/Download/SW/?item=EWARM-EVAL

▪ Start EWARM Workbench

▪ Choose File → Open → Workspace
• e.g.: <drive:>\sw-examples\

http://supp.iar.com/Download/SW/?item=EWARM-EVAL
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IAR Workbench – Main Window

▪ IAR Workbench

• Workspace on left side

of Workbench window

✓ If hidden then View→Workspace

• Source files on right

side of Workbench

window as tabbed

windows

• Project open

File → Open → Workspace → *.eww 

• For new projects

start with ‚mb9bfd1xt_template’
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IAR Workbench – Menu Bar

▪ IAR Menu Bar

File Control 
(new, open, 

save, etc.)

Edit Control
(cut, copy, 

paste, undo, 

redo)

Configuration 

Control
(e.g. RAM or ROM 

debugging)

Navigation Control
(Find, Bookmarks, File 

Navigation, etc.)

Build Control
(compile, make, 

stop build)

Debug Control
(Breakpoint, start 

Debug w/ and w/o 

download)



SHOW TITLE MM/DD/YY 49

IAR Workbench – Workspace

▪ IAR Workspace Window

Project Name

Sub Folder Modules

Main Modules

Module Includes

Project Description

Project Built Output
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IAR Workbench – Making Project

▪ Making the Project

• Use Make-Icon (      ), <F7> or

Menu: Project→Make

• Check for no errors in Output window

below

• Build errors are indicated by       or

In Output window and Source view
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IAR Workbench – Download to Target

▪ Download to Target and Start Debugging

• Use       Icon, <Ctrl>-D, or Project→Download and Debug

• A new menu bar will occur on sucessful connection to target

Reset 

Target

Stop

Step 

Over

Step 

Into

Step 

Out

Next 

Statement

Run to 

Cursor

Run

End 

Debugging

Trace 

Control
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IAR Workbench – Debug (1)

▪ Source Window

• The Source windows do not change contents but get additional 

information

✓ Current line (PC):

✓ Halted on Breakpoint:

✓ Halted on Data break (example):  

▪ Disassembly Window

• Shows ‘pure‘ disassebly view

• Shows mixed mode view
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IAR Workbench – Debug (2)

▪ Watch Window

• Watch

✓ Expressions/Variables have to be added by user and are updated by 

Halt/Breakpoint

• Quick Watch

✓ The Quick watch allows the user to calculate and recalculate expressions 

even with variables

✓ The drop down menu memorizes the last typed contents
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IAR Workbench – Simulator

▪ Simulator

• Mark Project File in Workspace

• Choose Project→Options

• Choose Simulator in Debugger Setup

• Start Simulator with usual      Icon
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KEIL µVision

Installation

Getting Started

Open Project

Build Project

Debug Project
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KEIL µVision IDE and Debugger Getting Started

▪ Install µVision from KEIL-CD or download latest version from KEIL 

Website

• Evaluation Version

✓ https://www.keil.com/demo/eval/arm.htm

✓ Registration required

▪ Install ULINK-ME 

• Special installation is not needed, because ULINK-ME acts as a USB 

Human Interface Device (HID) and thus needs no extra USB driver

▪ Install ULINK Pro (optional)

• ULINK Pro needs an own dedicated USB driver located in:

<Installation Path>\KEIL\ARM\ULINK

▪ Start µVision

https://www.keil.com/demo/eval/arm.htm
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KEIL µVision – Getting Started

▪ Choose Menu: Project→Open Project...

• Browse to: <drive:>\sw-examples\mb9bf56xr_gpio-v10\example\ARM\

• Choose mb9bf56xr_gpio.uvproj
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KEIL µVision – Main Window

▪ KEIL µVision

• Project window on left side of

IDE window

✓ Choose:

View→Project Window

if hidden

• Source files on right side

of IDE window as tabbed

windows

• Output window on bottom

side of IDE window
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KEIL µVision – Menu Bars (1)

▪ Menu Bar 1

• Can be moved in bar window area or set floating

File Control
(new, open, 

save, etc.)

Edit Control
(cut, copy, paste, etc.)

(indention, commenting)

Navigation Control
(Bookmarks + search, etc.)

(Text search, search in files, etc.)

Debug Control
(Start/Stop Debug Session, 

set/remove/disable 

breakpoints, remove/disable 

all breakpoints)

Project 

Window View

IDE 

Configuration
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KEIL µVision – Menu Bars (2)

▪ Menu Bar 2

• Can be moved in bar window area or set floating

Build Control
(Compile [Translate], 

Build, Rebuild, etc.)

Download 

to Target

Configuration 

Control
(e.g. RAM or ROM 

debugging)

Target 

Options

Manage Books, 

File Extensions, 

Environment

Manage 

Multi-

Project 

Workspace

MB9BF51x Release
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KEIL µVision – Project Window

▪ µVision Project Window

Project Name

Startup Code Subfolder

Startup Code Source and Header Files

Main Project Code Subfolder

Main Project Code Source and Header 

Files

Project Description Subfolder and 

Abstract File



SHOW TITLE MM/DD/YY 62

KEIL µVision – Making Project

▪ Making the Project

• Use Rebuild Icon

(      ) or

Project→Rebuild all target

files

• Check for no errors in

Output window below

• Build errors are shown in Output window.

✓ Can be double-clicked by showing the source line with a blue arrow
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KEIL µVision – Debug (1)

▪ Start Debugging

• Download to target first, when MCU Flash does not contain the current 

application openend and built in the IDE

✓ Use Download Icon (      ) or Menu: Flash→Download

• Start Debug Session

✓ Use Start/Stop Debug Icon (       ) or Menu: Debug→Start/Stop Debug 

Session

• Ending Debug Session

✓ Use same way as for starting debug session
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KEIL µVision – Debug (2)

▪ Debugging Icon Bar

• During a Debug Session there will be visible a new icon bar

Reset 

Target

Start/

Stop

Application

Step Control 
(Step in, out, etc.)

Show 

Source/Code 

Line of current 

PC

Show Windows (Command, 

Disassembly, Symbols, 

Registers, Call Stack)

Show (multiple) 

Windows
(Watch, Memory, Serial, 

Analysis, Trace, System 

Viewer)

Tool Box 
(can be 

customized)

Debug 

Restore 

Views
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KEIL µVision – Debug (3)

▪ Source View

• The Source windows do not change contents but get additional 

information

Active Breakpoint

Disabled Breakpoint

Current Program 

Counter

Current Cursor Line of 

Source Code

Code Lines with 

compiled Instructions 

(dark grey    )
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KEIL µVision – Debug (4)

▪ Disassembly View

• Mixed mode is selectable and deselectable

Active Breakpoint

Disabled Breakpoint

Current Program 

Counter

Current Cursor Line of 

Code highlighted in 

yellow background (   )
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KEIL µVision – Debug (5)

▪ Memory Window

• Up to 4 Memory windows can be displayed in tabs

• Memory is updated during runtime

• Memory window tabs are shared with Watch windows

▪ Register View

• Register view is a tab of the Project window

• Changes are highlighted in dark blue text

background

• Register tree knots can be expanded
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KEIL µVision – Debug (6)

▪ Variable Windows

• Watch Windows

✓ Up to 2 Watch windows are sharing their tabs with e.g. Memory and Local 

views

✓ Updated during runtime

✓ Any changes are highlighted in dark blue text backround color

✓ Displayed values can be changed by user during break

• Local View

✓ The local view shares the tab with e.g. Memory and Watch windows

✓ Any changes are highlighted in dark blue text backround color

✓ Displayed values can be changed by user during break



SHOW TITLE MM/DD/YY 69

KEIL µVision – Trace (ULINK ME)

▪ Trace via ITM

• Simple Trace views via Instrumentation Trace Macro is supported by 

µLINK ME

✓ Records

✓ Exceptions

✓ Counters
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KEIL µVision – Trace (ULINK Pro) (1)

▪ Trace via ETM

• Check settings in menu:

Flash→Configure Flash Tools... Tab:Debug

enables ETM pins

This small text file must be 

created first and sets the PFR 

and EPFR register bits for the 

TRACE pins.
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KEIL µVision – Trace (ULINK Pro) (2)

▪ Instruction Trace

• Real Time Trace recording

• Output can be filtered by several ETM and ITM events

• Trace buffer is held in PC memory and transfered to µVision on break
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KEIL µVision – Simulator

▪ Simulator

• The Core Simulator can be selected by the menu:

Flash → Configure Flash Tools... and then choosing Use Simulator

• Look & feel is like using ULINK debugger

• Controlable also with *.ini files
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Finally
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Recycling

▪ Gültig für EU-Länder:

• Gemäß der Europäischen WEEE-Richtlinie und deren Umsetzung in 

landesspezifische Gesetze nehmen wir dieses Gerät wieder zurück.

• Zur Entsorgung schicken Sie das Gerät bitte an die folgende Adresse:

▪ Valid for European Union Countries:

• According to the European WEEE-Directive and its implementation into 

national laws we take this device back.

• For disposal please send the device to the following address:

Cypress Semiconductor

198 Champion Court

San Jose, CA 95134 USA

▪ This board is compliant with China RoHS
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Cypress Support

▪ Please check the following website, for any available updates

www.cypress.com

Cypress maintains a worldwide network of offices, solution centers, 

manufacturer’s representatives, and distributors. To find the office 

closest to you, visit us at Cypress Locations.

http://www.cypress.com/
http://www.cypress.com/?id=1062

